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“ The purpose of C4ISR architectures Is to improve
capabilities by enabling the quick synthesis of “go-to-
war” requirements with sound investments leading to
the rapid employment of improved operational
capabilities, and enabling the efficient engineering of
warrior systems.”

- Adapted from: C4ISR Architecture Framework, Version 2.0
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STEVENS Components of the Framework

Irszicoie of Technology

¢ Common Definitions

¢ Common Products
and Data

¢ Common References
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Inter-relationships — JTA Representation

Irszicoie of Technology

Operational
View

| dentifies War fighter
Relationships and I nformation Needs

Specific Capabilities
Identified to Satisfy
Information-Exchange
Levelsand Other
Operational Requirements

'fechnica]
View

Prescribes Standards and

Technical Criteria Governing Conventions
Interoperable |mplementation/

i Procurement of the Selected
System Capabilities

Relates Capabilitiesand Characteristics
to Operational Requirements
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SMIABAE  System Architectures - Classical Representation

Imstivnte of Technology

Operational \iew.

1. Implementation
Functional Deficiency  [ERCERIeuseyiilg Identification of Approach Development of a ]

. - Identificati 2. Stakeholder i
Operat|ona| Def|c|ency ) l?neé}gnl]cee:]tlgzon Stakeholders Priorities Context Diagram —

Technology Fusion Approach dentification of 3. System Scope dentification of —
Technology Breakthrough Stakeholder Requirements System Objectives

Behavior Analysis Development of Use
Accidental Discovery Case Scenarios

1. Originating Requirements
2. Feature Priorities
3. External Interfaces

Functional \iew. Physical View

Development of a
Functional Diagram

Development of a
Physical Block Diagram

Identification of
Internal Interfaces

Identification of
Physical Interfaces

Clustering of System
Functions/Subsystems

Selection of
Technologies/Subsystems

Operational

Model Detail Design

Primary Functional System
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STEVENS Architecture Definition ??

L User’s/Operator’s View ¥

* Elements
— People
« External Users EEEE
 Internal Operators - .
« Maintainers - - -
— Human Machine Interface Devices @
» Displays
» Keyboards
e Mice/Joysticks
e Headsets
e Printers
— Interconnectivity
e Vision
* Audio
» Touch/Feeling
o User' s/Operator’ ’Maintainer’ s Environment
e System I mpacts
— Equipment Configuration and L ocation
— Training Requirements - Level of Expertise
— Cost of Operation

* Number of People Required
* Productivity
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Application (Functional) View
* Elements
— Capabilities Static View
» For Example:
— Interface Management

— Organic Tracker DB

— In-Organic Tracker DB

— Target Motion Analysis

— All Source Contact Management

— Launch Control ESM

RADAR

— Interconnectivity Off Board

» Messages Passed Between
Capabilities to Perform an End to
End Function

o System Design Impacts
— Resource Requirements
e Bandwidth
» Processing Throughput
e Storage
— System Complexity

Architecture Definition

> In-organic
Tracker DB

Interface -
Management Organic
Tracker
DB

v

All Source
Contact
Management
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STEVENS Architecture Definition

retitgie of Technology
I Technology

Application (Functional) View

Dynamic
: [ )
Interface Organic Inorganic Target All Source
Manage Track Track DB Motion Contact Control
ment DB Analysis Management
ESM > Tracker Data >
RADAR Tracker Data
SONAR
Tracker Data | Time Series Tracker Ddta >
Time Series [frpcker Data >
Calculate Contac
:| Range Rate
Calculate Contact
Bearing Rate
Calculate Contagt
Range
Contact Info to thﬁ
Operator
Addition@l Contact Info >
Combine Additional Confagt
;nft with Existing Data
OFF'BOARE Sensor{Dpta > Time Serles Sensor Data >
Eci ate Contact Info
«
ect Target for
osecution
mission to
losecution
Target Informétion to Weapon >
= L] || L] Order|Generation L
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STEVENS Architecture Definition
Data View

CIR Extract

Inbound
feeds

Staging DB

> uc 1

Source ——| TeamCatalog ‘

TeamSite

DB
? ¢ ASync. T
’ Batch
Server
P

Dpro Production
¢ p| CORE Prop o, | DB

QOutbound
feeds

Y v

Production
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Imstivnte of Technology b = 5-‘_ ;t
: Physical View o - %
Unix Operating  Unix Operating
System System
e Elements '
— Configuration ltems
* SUb%lgernS EZZ(%p.ering System
e Units PADAR
e« HWCl'sand CSCl’s
* Replaceable Assemblies
HP743
— I nter connection 2rix Oprdting System P
+ Physical Links A RS
— Networks B
— Point to Point HP743 ATM
. TCP/IP
e System Design I mpacts O pras

Unix Operating System

— Performance Limitations
— I nability to Upgrade
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Irszicoie of Technology

A Complete System
Description Includes All
Three Viewsof the
Architecture

— The People and Where
They Interact with the
System

— The Capabilities Within
the System and the
M essages that Flow
Between Capabilities

— The Hardware,
Software, and Physical
Links

. . e s SV ot
Architecture Definition # ?

Off-Board

Organic Target DB , T
HP744 :_r|1l;o7rj]4anl c Target DB
Unix Operating

Unix Operating System

System

Interface Management
HP743
Unix Operating System

Contact Data
Contact Data

All Source Contact
Management
HP743

Unix Operating System

3

Launch Control
HP743
Unix Operating System

b

Target Motion Analysis
HP743
Unix Operating System

. "

ATM .
TCP/IP Common Services
HP743

0C-3 Unix Operating System
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Documenting a System Architecture
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Imstivnte of Technology

Capturing an Architecture Baseline

Functional
Architecture
Refinement

Physical
Architecture
Refinement

Operational
Architecture
Refinement

Define Business

Requirements N
Baseline (1)

Define
Functional
Areas

v

Define System
Requirements

v

Requirements to
Functional Areas

Allocate

Allocate

2

~

v

Allocate Derived

Requirements to

>

Diagrams (2a, 2b)

Physical Application ﬁl»

Diagrams by
Functional Area (5)

Links (7)
— Messages (8)

Allocat e>

>

» Application Landscape €4—¥% pDefine Use Cases 4)

v

Interaction
Diagrams (6)

Application Level ;"
Architecture Test
¢ Scenarios (9)
Development
: v
Functional Test
Verification Test Cases

Applications
v Verify
Requirements
Verification _
Matrix (10) Verify

* <—‘
Execute
» SIT
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ML Capturing an Architecture Baseline

« Why |s Capturing the Baseline Important

— Clear, Concise Problem Definition to the
Development Team

e Build What the Customer Wants
— Test Planning

e Definition of the Test Environment

« Data Migration and Initialization

— Reduce Learning Curvefor Individuals
Coming onto the Proj ect

e FutureUpgrades
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STEVENS (1) Technical Scope Document é

Imstivnte of Technology

Application
S/W Impact| Data Link Schedule Information
Design/
Code/ SWIT/ Delivery
Affected Test Unit Test |to System
Regm't Application S|M|L|N]|M N | M |Requirement Description Dates Dates Test
Target motion Localization to within 10% of actual in both bearing 7/1/02 - | 10/1/02 -
1|Analysis X X and range for contacts held by organic sensors 10/1/02 | 12/1/02 | 12/5/2002
All Source Contact Multi-sensor correlation of contacts held on 8/1/02 - | 10/1/02 -
2|Management X organic sensors 10/1/02 | 11/15/02 |11/15/2002
Contact association across 5000 contacts from
All Source Contact in-organic sensors within 15 minutes of receipt | 7/2/02 - | 12/1/02 -
3|Management X | X X of data 12/1/02 2/1/03 2/3/2003
All Source Contact 8/15/02 - | 12/1/02 -
4|Management X X Contact association across all sensors 12/1/02 2/1/03 | 2/3/2003
Full operational capability with 4 or less 9/1/02 - | 11/1/02 -
5]All X X operators 11/1/02 12/1/02 | 12/5/2002
10/1/02 - {11/15/02 -
5.1|Common Senices | X All Operators shall receive the same training 11/15/02 | 12/1/02 | 12/5/2002
0.995 Operational Availability for a 90 day 9/1/02 - | 12/1/02 -
6]All X X X |mission 12/1/02 2/1/03 2/3/2003
Horizontal launch of ADCAP and Tomahawk 9/1/02 - | 12/1/02 -
7|Launch Control X weapons 12/1/02 2/1/03 | 2/3/2003
7/1/02 - 111/15/02 -
8[Launch Control X | X X Vertical launch of Tomahawk weapons 11/15/02 | 2/1/03 | 2/3/2003
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(2b) Application Landscape

Imstivnte of Technology
Role or Capabilities Version Technical Infrastructure
Application
Acronym/Name
Common Services | Display formatting 1.0a Unix Operating System on
(C9 Auto Plots HP743 Single Board
Performance Monitoring Computer
Diagnostics
Target Motion MATE, KAST, and Polar 1.0 Unix Operating System on
Analysis(TMA) Coordinate Ranging Algorithms HP 743 Single Board
Computer
Organic Sensor Storage and Retrieval of contact 4.11a Unix Operating System on
Database time seriesinformation (contact id, HP777 Server

bearing, base frequency, D/E angle)
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mstitate of Technology XXX Easy Access
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Enterprise System
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STEVENS

Imstivnte of Technology

(3) Data Initialization and Migration

Requirement Data Type Data Sour ce Attribute Test Requires Attribute
Needed Toggle/Change?
1 Contact TMA Range Yes
Position
2 Contact Off-Board X,Y,Z position | Yes
Position Sensorsvia and time of
Interface
M anagement

Copyright — Stevens I nstitute of Technology - Dinesh Verma; dverma@stevens-tech.edu; (210) 216-8645; Use Allowed with Attribution




STEVENS

(4) Use Cases

Imstivnte of Technology
7. Common
Services
b
1. Collect 4. Collect
%ng)r Dma SenSOI’ Data
. Associate
In-organic
2 Pe_rfor_m Contact
Localization Data
6. Associate
3.Prosecute N 7' Al Contact
System System System Capability System Invoked | Predecessor(s) | Average | Peak Hyper
Use Use Case Test by: Rate Rate link
CaselD | Name Scenario
1 Collect Store Time Series Data Test Dataflow None 12Hzper | 12Hz
Organic from Organic Sensor Organic DB contact per
Sensor Data | Trackers Store/ contact
Schema
2 Perform Calculate contact bearing Test Dataflow Collect Organic
Locdlization | rate, range, and rangerate | Localization Sensor Data
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(5) Functional Area Physical Diagrams

Irszicoie of Technology

ESM 1 Tracker Data
9 10
o
: g
2 Tracker Data % [a)
RADAR Tracker Data = E
3 5
o
Sonar ° Weapon Data Weapons
> Interface
External

Communications

TCP/IP
0OC-3

—13
System
Administration
Data
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Imstivate of Technology Logical (FunCtional) VieW EJE o

Dynamic

Interface Organic . Target All Source
Manage Track 'ang[:?(agg Motion Contact
ment DB Analysis Management

ESM Tracker Data

P

RADAR Tracker Data

SONAR

Tracker Data >

Calculate Contac
Range Rate

Calculate Cont
Bearing Rate
Calculate Cont

Range

Contact Info to th
Operator

Additi Contact Info

es Sensor Data

OFF-BOARD Sensor

ect Target for

osecution
mission to
losecution
Target Informétion to Weapon
Orde]@eneration
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(7) Links

Imstivnte of Technology
I/F Source | Destination N | Protocol | Physical Capacity | Average Peak Owner
No. M Utilization | Utilization
E
1 ESM Interface N | Request | NTDS 667 30% 60%
M anagement [Ackno | Fast Kbytes/S
wledge ec
2 RADAR | Interface N [ Request | NTDS 667 20% 25%
M anagement /Ackno | Fast KbytedS
wledge ec
3 Sonar Interface N | Request | NTDS 667 40% 75%
M anagement [Ackno | Fast Kbytes/S
wledge ec
4
5 TMA User M| TCPIP | ATM 155 10% 20%
Mbytes/S
ec
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STEVENS (8) Messages

Imstivnte of Technology

M essage M essage Description Link N | System Use Size (Bytes)
Name M | CaselID

E
ESM _Trac | ESM Contact Tracker Data (contact id, bearing) | 1 N |1 128 Bytes
k_Data
RADAR_T | RADAR Contact Tracker Data (contact id, 2 M| 1 64 Bytes
rack_Data | bearing)
Sonar_Trac | Sonar Contact Tracker Data (contact id, 3 M1 256 Bytes

k_Data bearing, base frequency)
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(9) Test Scenarios

System
Use Case
Name

Test Scenario
Name

Test Scenario Description

Test Case Names

Driving
Application

Collect
Organic
Sensor Data

Test Organic DB
Store/ Schema

Using simulated or real data from
ESM, RADAR, and Sonar provide
inputs to Interface Management to
be forwarded to the Organic
Sensor Database for storage and
retrieval.

Test ESM Inputs
Test RADAR Inputs
Test Sonar Inputs

Perform
Localization

Test Localization

Using tracker datainformation
contained in the Organic Sensor
Database, validate the
requirements for contact range and
bearing localization

Test MATE
Test KAST

Test Polar
Coordinates
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Imstivnte of Technology

(10) Requirements Verification Matrix

Requirement | Capability SWIT | Unit Factory Installation | Sea Trials
Test Acceptance
Test
1| TMA T D D
2 | Asc™ T D D
3 | Asc™m D T
4
5
5.1
6
7
8
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» 10 Elements are Required to Document an Architecture
— 1. Requirements Baseline — Technical Scope
—2a. Physical View
— 2b. Functional Description
— 3. Data I nitialization and Migration
—4. Use Cases
— 5. Allocation of Requirementsto Physical/Functional
View
— 6. Interaction Diagrams (Data Flow)
—7.Links
— 8. M essages
—9. Test Scenarios
—10. Requirements Verification Matrix (RVM)
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e Problem Statement:

— Current market trendsin the commer cial defence market
* Reduced development cost
* Increased use of sub-suppliers
* Increased use of COTS components
* Higher turnover ratein development department
— ...suggest that traditional architectural and system design

documentation during product development may no longer be

sufficient for current and futurelong-term (and low volume) product
sustainment.

— Theobjectiveisto develop a system capable of being produced in
small volumes the coming 30 years, and capable of being maintained
even longer,

— In light of constantly evolving functional capabilities, changing
physical implementation and changing wor kfor ce

— In a cost effective manner
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The Architecture and Systems Model 'S,?
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— The systems model — shall be a product of the entire
development effort, and shall contain what was kept as
well aswhat was discarded

— The systems model will act asthe product’s collective
memory

If the systems model is unknown (undocumented), it
will be impossible to cope with future changes with
reasonable resources given our production volume
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SIIE  System Model — Information structures  {#

Imstivnte of Technology

» Thefollowing structuresrealize the system mode!:
* Requirementshierarchy

— All contract requirements—with requirement breakdown areinternally
ordered in a traceable structure

— Analyses performed as part of requirement breakdown are attached to all
influenced requirements

—Test- and verification information ar e attached directly to the requirements
o System hierarchy

—All systemsareordered in astringent hierarchy (a stingent hierarchy is
defined as a hierarchy in which each object can have only one parent (as
opposed to therequirement hierarchy, where one requirement can have
multiple parents))

— Textual infromation used in specifications and similar, are attached directly to
the system

e Functional hierarchies
—All functionsare ordered in a set of stringent hierarchies

— Each function shall be allocated to one system (appliesto the leaf-node
functions)

—All functional requirements are allocated to the function
— Data- and control flow between functions are given by their internal relations
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MUAIEE  System Model — Information structures '-F ?
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e System physical hierarchies
— Modelsthe physical architecturefor each subsystem
— System functions ar e allocated directly to the parts
— Non-functional requirementsare allocated to the part
e Assembly hierarchy

— Onedtringent hierarchy containing all partsorganized in
assemblies

— Physical requirements following from the ” packaging process’ are
allocated to on applicable levels

— Failure modes ar e attached to the component
— Testpointsareidentified in the structure

— Signal tracing are given by therelations among the parts/
assemblies, and their functional counterpart aregiven by the
ralationsto the functional hierarchies
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STEVENS ?1? :

If you are interested in this research, and would be willing to
share your thoughts in a telephonic interview/Zdiscussion,
please give us your contact information:

Name:
Phone:

Email;
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